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Simple guide to installation
To install Lasergene as a standalone product:

1. Log in to your DNASTAR account and go to the My Licenses page. Press the appropriate button
(Lasergene for Windows, Lasergene for Mac OS X) to download the standalone installer. Leave
this page open, as you will need the product key in the next step.

2. Run the installer, following the instructions on each screen. If prompted to authorize, choose
Standalone and enter your 17- or 36-character product key, available on the My Licenses page.

To install Lasergene on a network:

Network installation involves two stages: installing the license server on host computer, and installing
Lasergene on the client computers. Installing a Lasergene network for the first time or upgrading from an
older version both take just a few simple steps.

Part A: License server installation:

On the computer designated to run the Lasergene license server:

1. Log in to your DNASTAR account and go to the My Licenses page. In the Installers column,
download the license server by clicking the Network Server button corresponding to the operating
system for the license server machine (Server for Mac OS, Server for Windows). Leave this page
open, as you will need the product key in the next step.

2. Run the installer, following the instructions on each screen. If the server machine uses a firewall,
follow the instructions in Handle a firewall on the license server machine. After the installation

If you have previously installed the license server on one host computer and need to move
it to a different computer, please contact our support staff for help facilitating the transfer.*
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finishes, you will be asked to enter a product key for authorization. The key is available on the My
Licenses page.

Note: If authorization seems to finish but the popup above is still open, locate the following
popup—which may be hidden beneath other windows—and click OK.

3. Once authorized, a new LasergeneClient’x’ folder (where ‘x’ is the version number) will be placed on
your server’s desktop. This folder contains:

• A file named IP Address [x.x.x.x].txt – Make a note of this IP address as it will be needed to
activate Lasergene on the client computers.

• Several *.lshost files – Needed for advanced installations.

• An HTML file – Instructions for client installation.

Part B: Client installation:

On each of the client machines that will be running Lasergene:

1. Log in to your DNASTAR account and go to the My Licenses page. Press the appropriate button to
download the client installer (Lasergene for Windows, Lasergene for Mac OS X).
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2. Place the downloaded installer into the LasergeneClient’x’ folder (see above: Part A, step 3). This
folder contains the files LG‘x’.lshost, NG‘x’.lshost, AS‘x’.lshost. Then copy the entire folder to the
client machine.

If you are using MacOS 10.14 or earlier, the folder can be placed anywhere, such as the client
desktop. If you are using MacOS 10.15 and later the LasergeneClient’x’ directory should be placed at
the top level of the user directory or the shared user directory, i.e. /Users/USERNAME/
LasergeneClient or /Users/Shared/LasergeneClient.

3. On each client computer on which you wish to install Lasergene, launch the installer from within the
LasergeneClient’x’ folder. This automatically causes the local access point to be directed to the
correct license server computer. Follow the instructions in the installation wizard.

4. When prompted, choose Network, and type in the IP address for the license server machine (see
above: Part A, step 3).

For in-depth information on standalone and network/client installation, see Detailed guide to installation. For
detailed information on network maintenance and troubleshooting, see Network license server
administration.

IMPORTANT: If you are using Mac OS 10.15 or later and instead run the installer from
~/Desktop, ~/Documents, or ~/Downloads, the .lshost or .keyhost files will not be
properly copied to the Licenses directory.
*
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Detailed guide to installation
Though most users will only need our Simple guide to installation, the following topics offer a more detailed
walk-through of the installation process:

• Network license server installation for Windows and Macintosh (troubleshooting)

• Standalone and network client installation for Windows and Macintosh (troubleshooting)

• Special types of installation:

◦ Installing Lasergene quickly on multiple client machines
◦ Installing and uninstalling from the command prompt or Terminal
◦ Installing Lasergene on KeyServer systems
◦ Installing ArrayStar on a Macintosh machine
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License server installation for Windows
The license server machine can be either a Macintosh or Windows computer and can serve any
combination of Macintosh and Window client machines up to your license limit. Choose a machine that will
always be turned on, accessible from your network, and which has a static IP address. Administrator
privileges are required to perform license server installation.

This section explains in detail how to install and authorize the DNASTAR network license server software for
on a Windows computer. If your server is a Macintosh computer, follow these instructions instead. If you will
be performing a standalone installation rather than a network one, proceed to this topic instead.

To install the License server on a Windows computer:

1. Log in to your DNASTAR account and go to the My Account page. Click the Network Server button
Server for Windows to download the installer.

1. Double-click on the DNASTAR License Server Win Installer executable (*.exe) file to initiate
installation.

2. In the Welcome dialog, read the instructions, and then click Next.

3. In the License Agreement dialog, read the agreement and choose I accept the agreement if you
accept (required for installation). Press Next.

4. In the Installation Directory dialog, click Next to install in the default location (C:\Program Files
(x86)\DNASTAR-LicenseServer). Otherwise, you may click the browse (folder) icon to install in a
custom location. If you are upgrading from a previous Lasergene Network license server, the new
version must be installed in the same directory as the previous version. Once the new version of the
license server is installed, you will still be able to run previous network client versions during your
client upgrade process. After choosing a location, click Continue. Then click Next.
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5. In the Select Components dialog, you can highlight a component to display information about it in the
area to the right. Leave both Components boxes checked and click Next.

6. In the Important Notes dialog, read the information and press Next.

7. In the Ready to Install dialog, click Next to initiate installation.

8. If a license for the current version of the License Server is not detected, the License Server
Authorization dialog will open.
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Enter your alphanumeric product key into the License field, and then click Authorize. Your license
key is shown in the My Account page of the DNASTAR website.

9. A progress bar will be displayed. When you receive a message that authorization was successful,
click OK.

After authorizing the software, the following events will occur:

• A new folder named LasergeneClient‘x’ (where ‘x’ is the version number) will appear on the desktop.
The detected IP Address of the server computer, required for network client installation, can be found
in this folder as a file named IP Address [x.x.x.x].txt.

• A browser window entitled Installing Lasergene Software on Client Computers will open. This
page provides information and links for installing the DNASTAR Lasergene network client. The page
can be re-opened later from the LasergeneClient‘x’ directory by double-clicking on Lasergene
Installation.html.

Having issues with this procedure? Check out these troubleshooting topics:

• Handle a firewall on the license server machine

• Troubleshoot license server authorization

• Install on a machine with an existing SentinelLM network

• Verify the Lasergene version number

Otherwise, proceed to Standalone and network client installation for Windows or Macintosh.
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License server installation for Macintosh
The license server machine can be either a Macintosh or Windows computer and can serve any
combination of Macintosh and Window client machines up to your license limit. Choose a machine that will
always be turned on, accessible from your network, and which has a static IP address. Administrator
privileges are required to perform license server installation.

This section explains in detail how to install and authorize the DNASTAR network license server software for
on a Macintosh computer. If your server is a Windows computer, follow these instructions instead. If you will
be performing a standalone installation rather than a network one, proceed to this topic instead.

To install the License server on a Macintosh computer:

1. Log in to your DNASTAR account and go to the My Account page. Click the Network Server button
Server for Mac OS X to download the installer.

2. Double-click on the Lasergene ‘x’ License Server Mac Install disk image (.dmg) to open a window
containing the application (.app).Then double-click on .app file to launch the installer.

3. In the Welcome dialog, read the instructions, and then click Next.

4. In the License Agreement dialog, read the agreement and choose I accept the agreement if you
accept (required for installation). Press Next.

5. In the Important Notes dialog, follow the on-screen instructions and click Next.

6. In the Ready to Install dialog, press Next.

7. If a license for the current version of the License Server is not detected, the License Server
Authorization dialog will open. Enter your alphanumeric product key into the License Server Product
Key field, and then click Authorize to initiate installation.
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8. A progress bar will be displayed. When you see a notification that installation has completed
successfully, click Close.

After authorizing the software, the following events will occur:

• A new folder named LasergeneClient‘x’ (where ‘x’ is the version number) will appear on the desktop.
The detected IP Address of the server computer, required for network client installation, can be found
in this folder as a file named IP Address [x.x.x.x].txt.

• A browser window entitled Installing Lasergene Software on Client Computers will open. This
page provides information and links for installing the DNASTAR Lasergene network client. The page
can be re-opened later from the LasergeneClient‘x’ directory by double-clicking on Lasergene
Installation.html.

Having issues with this procedure? Check out these troubleshooting topics:

• Handle a firewall on the license server machine

• Troubleshoot license server authorization

• Install on a machine with an existing SentinelLM network

• Verify the Lasergene version number

Otherwise, proceed to Standalone and network client installation for Windows or Macintosh.
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Troubleshoot license server installation
• Handle a firewall on the license server machine

• Troubleshoot license server authorization

• Install on a machine with an existing SentinelLM network

• Verify the Lasergene version number
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Handle a firewall on the license server
machine
If the server computer’s firewall is “on,” you will need to allow an exception for the DNASTAR lserv
(Macintosh) or lservnt.exe (Windows) file. In most cases, this exception is set up automatically during
installation.

To set up the exception manually:

On Windows:

1. Determine whether a firewall is present by navigating to the Control Panel and searching for
Windows Firewall. Note whether the firewall is On or Off.

2. If the firewall is On, check whether there is an exception for Sentinel RMS Development Kit License
Manager (the name of the license manager software used by DNASTAR).

3. If no exception is listed, follow Microsoft’s instructions for adding a program to the firewall. When
prompted to choose a program path, use the Browse button to navigate to C:\Program Files
(x86)\DNASTAR-LicenseServer\Server\lservnt.exe.

4. In the “allowed programs” dialog, check all of the boxes (Domain, Private, and Public) corresponding
to Sentinel RMS Development Kit License Manager.

5. Click OK to save your changes and exit.

On Macintosh:

1. Determine whether a firewall is present by navigating to System Preferences > Security and
Privacy and clicking on the Firewall tab. Note whether the firewall is On or Off.

2. If the firewall is On, check whether there is an exception for lserv, located at ~/Library/
DNASTARLicenseServer/lserv.

3. If no exception is listed, click the Firewall Options button and follow Apple’s instructions for adding a
program to the firewall. The “allowed programs” dialog should now say that lserv is set to Allow all
incoming connections.

4. Click OK to save your changes and exit.
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Troubleshoot license server authorization
After Network License Server Installation, this dialog will prompt you to authorize the license server
software.

If you enter unrecognized information and click Authorize, you may receive one of the error messages in
the table below.

If you received this error message… …try this solution:

Please enter a valid product key.

Check that you have entered the product key correctly, and
that it is the appropriate key and type (Standalone/Client
vs. Network) for the Lasergene application and version that
you are installing.

The key you entered is for a network license and
cannot be used to authorize a standalone client.

There appear to be no keys currently authorized
for the product key, product, or version number
provided. If you feel that this is in error, please
contact DNASTAR.

• If authorizing the license server, ensure you are
using the license server License Manager located
in the C:\Program Files (x86)\DNASTAR-
LicenseServer\Server folder.

• If authorizing the Client, verify that you are using
the Client License Manager available through the
Navigator or in the CFiles (x86)\DNASTAR\
License Manager directory.

• If you have both Macintosh and Windows product
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keys, verify the key matches the platform on which
you are authorizing.

• If you have had previous versions of the software,
verify that you are using the product key for the
current version of the software.

To address the issue, click the OK button in the error message. This returns you to an enhanced version of
the original authorization dialog.

Correct your earlier entry using the solution in the table above, then click Authorize. If you receive the error
message again, you may wish to perform a manual authorization as detailed below.

Performing a manual authorization:

Manual authorization is only for the license server and standalone versions of Lasergene, and does not
apply to client installations.

1. In the enhanced version of the License Server Authorization dialog, click the Manual button.

2. In the “Step 1 of 4” dialog, click the Copy Computer ID button to copy the unique ID number to your
computer’s clipboard. Then click Next.

Note: You can also launch this version by entering either an asterisk (*) or xxxx-xxxx-
xxxx in place of the product key. Or, on Windows, press Ctrl+Alt+[Back button]; on
Macintosh, press Option+Cmd+[Back button].
*
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3. In the “Step 2 of 4” dialog, click the Launch Browser button.

The browser opens to the DNASTAR License Server Authorization web page.
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• Insert the cursor in the Your Computer ID field. To insert the ID that was stored in your
clipboard, use Ctrl/Cmd+V, or right-click and choose Paste.

• Open the DNASTAR My Licenses page. Copy your Product Key, then return to the Manual
Authorization page and paste it into the Product Key field.

4. Click Submit. An additional section appears on the Manual Authorization page. Checkmarks denote
the applications that will be installed.

Note: If nothing is checked and the Submit and Activate buttons are disabled, you
may have used up your available licenses. To check on your license status or release a
license that was used in error, please contact support@dnastar.com.
*
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5. (optional) If you do not want to install a particular application, remove the checkmark next to its name.

6. Press Activate. If activation was successful, a block of License Text will appear.

7. Highlight all the text under License Text: and above the line For assistance. Copy the text into your
clipboard using Ctrl/Cmd+C, or by right-clicking and choosing Copy.

8. Go back to the Manual DNASTAR License Server Authorization dialog and click Next.

9. Click Paste License Text to paste the copied text into the License Text field.

10. Click Finish. If authorization was successful, you will receive a message. This message is considered
the Step 4 of 4. Click OK to finish the manual authorization.
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Install on a machine with an existing
SentinelLM network
You can run a DNASTAR network if you already have a SentinelLM network running for another program. If
you already have a SentinelLM network running on the same server where you want to install the DNASTAR
license server, you will simply need to combine the license files for both programs.
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Verify the Lasergene version number

In order to allow companies to run previous network client versions during the client upgrade process, we
retained the original license server feature names of Lasergene 6, SeqBuilder 6, SeqMan 6, etc. As a result,
you will always see “Lasergene 6” in the feature list on the server. A quick way to verify you have installed
the most recent version of Lasergene is to open the LasergeneClient’x’ folder (where ‘x’ is a number) and
look at the version numbers of the .lshost files.

This topic applies only to network installations.*
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Standalone and network client installation for
Windows
This section explains how to install DNASTAR Lasergene as a network client working in tandem with a
DNASTAR license server. These instructions apply to all locally-installed DNASTAR applications.
Administrator privileges are required to perform this installation. If you will be installing on Macintosh, use
these instructions instead.

Before starting the steps below, be sure to:

• Close all existing DNASTAR software.

• (Network client installation only) Follow all steps for the Network license server Installation on
Windows or Macintosh.

To perform standalone or network client installation on Windows:

1. Log in to your DNASTAR account and go to the My Account page. Press Lasergene for Windows to
download the standalone installer (top image) or network client installer (bottom image).

2. Double-click on the DNASTAR Lasergene Installer executable (*.exe) file to initiate installation.

3. Follow the instructions in the DNASTAR Lasergene Installer screen, and then click Next.

4. Read the agreement in the License Agreement screen. If you agree with the terms (required for
installation), select the I accept the agreement button, and then click Next.

5. In the Installation Directory screen, click Next to install in the default location (recommended).
Otherwise, click on the folder icon to select a non-default location for the installation.
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6. In the Ready to Install screen, click Next. You will see a progress bar showing the progress of the
installation.

7. If a license for the current version of Lasergene is not detected, the Lasergene Authorization dialog
will open.

• If you are performing a standalone installation, select Standalone and enter your Product Key.
Your Product Key can be found on your My Licenses page of the DNASTAR website. (If you
cannot find the key there, please contact us). Press the Authorize button. If you authorized the

Note: If you cancel an installation in progress, you will be asked to confirm the cancellation.
If you respond Yes, a second popup will ask if you would like to file a technical support
request to get help with the installation. Clicking Yes in this dialog will take you to the
DNASTAR website’s Technical Support Request page.

*
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software using a recognized key, you will receive the following message. Press OK.

• If you are installing client software as part of a network installation, and the correct *.lshost files
are in the same directory as the installer executable, you will not be prompted to license the
software. Otherwise, select Network and enter the License Server’s Hostname or IP address
in the text box. The IP Address can be found in the LasergeneClient’x’ folder created on the
host computer’s desktop during License Server installation. Click the Authorize button. If you
authorized the software using a recognized key, you will receive the following message. Press
OK.

• If you do not wish to authorize at this time, press Cancel and open the authorization dialog at a
later time by launching Navigator and choosing License Manager from the Utilities section.

8. When installation is complete, press Finish. The DNASTAR Navigator will launch automatically.

The installed Lasergene applications can now be accessed via the DNASTAR Navigator or the DNASTAR
Lasergene ‘x’ folder in the Start menu.

If you receive an Unable to authorize message when installing a network client, see
Troubleshoot license server authorization.*
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Standalone and network client installation for
Macintosh
This section explains how to install DNASTAR Lasergene as a network client working in tandem with a
DNASTAR license server. These instructions apply to all locally-installed DNASTAR applications.
Administrator privileges are required to perform this installation. If you will be installing on Windows, use
these instructions instead.

Before starting the steps below, be sure to:

• Close all existing DNASTAR software.

• (Network client installation only) Follow all steps for the Network license server Installation on
Windows or Macintosh.

To perform standalone or network client installation on Macintosh:

1. Log in to your DNASTAR account and go to the My Account page. Press Lasergene for Mac OS X to
download the standalone installer (top image) or network client installer (bottom image).

2. Double-click on the disk image (.dmg) to open a window containing the installer app (.app).

3. Move the standalone/client installer file (.app) into the LasergeneClient’x’ folder that was created
during License Server installation. This folder contains the files LG‘x’.lshost, NG‘x’.lshost,
AS‘x’.lshost. Then copy the entire folder to the client machine. If you are using MacOS 10.14 or
earlier, the folder can be placed anywhere, such as the client desktop. If you are using MacOS 10.15
and later the LasergeneClient’x’ directory should be placed at the top level of the user directory or the
shared user directory, i.e. /Users/USERNAME/LasergeneClient or /Users/Shared/LasergeneClient.

WARNING: If you are using Mac OS 10.15 or later and instead run the installer from!
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4. Double-click on the installer app to launch the installer.

5. Follow the instructions in the DNASTAR Lasergene Installer screen, and then click Next.

6. In the License Agreement dialog, read the agreement. If you agree to the terms (required for
installation), select I accept the agreement and then press Next.

7. In the Installation Directory screen, click Next to install in the default location (recommended).
Otherwise, click on the folder icon to select a non-default location.

8. In the Ready to Install screen, click Next. You will see a progress bar showing the progress of the
installation.

9. If a license for the current version of Lasergene is not detected, the Lasergene Authorization dialog
will open.

~/Desktop, ~/Documents, or ~/Downloads, the .lshost or .keyhost files will not be
properly copied to the Licenses directory.

Note: If you cancel an installation in progress, you will be asked to confirm the cancellation.
If you respond Yes, a second popup will ask if you would like to file a technical support
request to get help with the installation. Clicking Yes in this dialog will take you to the
DNASTAR website’s Technical Support Request page.

*
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• If you are performing a standalone installation, select Standalone and enter your Product Key.
Your Product Key can be found on your My Licenses page of the DNASTAR website. (If you
cannot find the key there, please contact us). Press the Authorize button.

• If you are installing client software as part of a network installation, and the correct *.lshost files
are in the same directory as the installer app, you will not be prompted to license the software.
Otherwise, select Network and enter the License Server’s Hostname or IP address in the text
box. The IP Address can be found in the LasergeneClient’x’ folder created on the host
computer’s desktop during License Server installation. Click the Authorize button.

• If you do not wish to authorize at this time – Press Cancel and open the authorization dialog at
a later time by launching Navigator and choosing License Manager from the Utilities section.

If you used a recognized key, you will receive a message containing an OK button Press OK to
continue the installation.

10. When installation is complete, press Finish. The DNASTAR Navigator will launch automatically.

The installed Lasergene applications can now be accessed via the DNASTAR Navigator or the
/Applications/DNASTAR folder.

If you receive an Unable to authorize message when installing a network client, see
Troubleshoot license server authorization.*
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Troubleshoot standalone and network client
installation

• Run command prompt versions of DNASTAR software

• Troubleshoot client software authorization

• Troubleshoot the error
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Run command prompt versions of DNASTAR
software
After installing and licensing SeqNinja (sometimes called DNA*) and/or SeqMan NGen, they can be run
immediately from the Navigator, or from the DNASTAR Lasergene ‘x’ folder in the Start menu (Win) or the
Applications folder (Mac), without restarting the client machine.

For Windows users only: If you want to run the xng, sng, qng or seqninja applications through the
command prompt and the path to these items is not present (i.e., from an earlier installation), you may first
need to log off and log back in again on the standalone or client machine.
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Troubleshoot client software authorization

The authorization key for Lasergene network client software is the IP address of the license server
computer. If you are the end user, please contact your system administrator for this information.

If you are the system administrator, you can find the license server’s IP address by opening the
LasergeneClient‘x’ folder (where ‘x’ is the version number) located on the desktop. The number in the file
name IP Address [x.x.x.x].txt is the authorization key for the network clients.

To allow uninterrupted communication between the client software and the License Server, you must install
the DNASTAR License Server on a computer with a static IP address. If the License Serve’s IP address
does change after installation, see License server’s IP address has changed.

This topic applies only to network installations.*

Lasergene Installation Guide - 17.3_en

Copyright DNASTAR, Inc. 2022 Page 28 of 85



Troubleshoot the error “A different version is
running”
If you receive the error "A different version of Lasergene is running" when you try to launch a Lasergene
application, but another version of Lasergene actually isn’t running, there may be a lingering .state file from
another version that needs to be deleted.

The solution is to locate and delete files named STARDM*.state, …where ‘*’ represents the version number.
These files may exist in the following directories:

Windows:

• C:\Users\username\AppData\Local\DNASTAR\DataManager

• C:\ProgramData\DNASTAR\DataManager

Macintosh:

• Hard Drive:Library:Preferences:DNASTAR:DataManager

• Hard Drive:Users:username:Library:Preferences:DNASTAR:DataManager

If you find any of the .state files listed above, delete them. Once the files are deleted, the error should no
longer appear.
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Troubleshoot failure to launch SeqMan NGen
or ArrayStar
In order to launch SeqMan NGen and ArrayStar on Windows, the following must be installed on the same
Windows machine.

• Windows 7 with Service Pack 1 / or Windows 8.1 / or Windows 10

• NET Framework 4.7 or higher

If you receive an error message and the application fails to launch, perform these steps:

1. Use Windows Update to ensure the latest important updates to Windows are installed.

2. Install any .NET updates still listed in Windows Update.

3. Reinstall Lasergene.
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Special types of installation
The following topics deal with special types of installation:

• Install Lasergene quickly on multiple client machines

• Install and uninstall from the command prompt or Terminal

• Install Lasergene on KeyServer systems

• Install ArrayStar on a Macintosh machine
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Install Lasergene quickly on multiple client
machines
This topic applies only to network installations. Normal network client installation requires following the
steps in the Standalone and network client installation (Windows / Macintosh) for each client machine.

Advanced installation lets you distribute a folder containing a preconfigured Lasergene installation to
computers on your network, allowing quick installation on multiple machines.

1. (Macintosh only) Double-click on the disk image (.dmg) to open a window containing the installer app
(.app).

2. For both Macintosh and Windows, move the executable file (.exe) or installer app (.app) to the
LasergeneClient‘x’ folder, adjacent to these three files: LG‘x’.lshost, NG‘x’.lshost, AS‘x’.lshost. If you
are using MacOS 10.15 and later the LasergeneClient’x’ directory should be placed at the top level of
the user directory or the shared user directory, i.e. /Users/USERNAME/LasergeneClient or /Users/
Shared/LasergeneClient.

3. Copy the entire LasergeneClient‘x’ folder to a USB drive or a shared network drive that can be
accessed by each client.

4. You may now run the DNASTAR Lasergene Installer for Macintosh or Windows on each of the client
machines. Be sure to run the installer from the LasergeneClient‘x’ folder to ensure that the *.lshost
files are automatically recognized by the installer.

WARNING: If you are using Mac OS 10.15 or later and instead run the installer from
~/Desktop, ~/Documents, or ~/Downloads, the .lshost or .keyhost files will not be
properly copied to the Licenses directory.

!
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Install and uninstall from the command
prompt or Terminal
Instead of performing a traditional installation, you may optionally install and/or uninstall DNASTAR software
from the command prompt (Win) or Terminal (Mac). This type of “silent” installation/uninstallation does not
require user interaction. Installation runs in the background, without any dialogs or notifications.

• Win: Instructions for installing the License Server and standalone/client software. If you do not
authorize at the time of installation, you may authorize silently at a later time.

• Mac: Instructions for installing the License Server and standalone/client software. If you do not
authorize at the time of installation, you may authorize silently at a later time.
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Install the license server on Windows
As an alternative to traditional License Server installation, you may also install the DNASTAR License
Server from the Windows command prompt:

1. Download the network installer executable DNASTAR’x‘LicenseServerWinInstaller.exe (where ‘x’
denotes the version number).

2. On the network host machine, open a command prompt.

3. Drag the installer executable into the command prompt to add the path. After the path, type a space
and the following text:

--mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

Example of the final command:

C:\Users\<username>\Desktop\DNASTAR1500LicenseServerWinInstaller.exe --mode
unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

4. Press Enter. If a security warning appears, choose Yes.

A folder named LasergeneClient’x’ will appear on the desktop. This folder contains the .lshost files you will
need to set up the clients.
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Install the license server on Macintosh
As an alternative to traditional License Server installation, you may also install the DNASTAR License
Server from the Macintosh Terminal:

1. Download the network installer executable DNASTAR’x‘LicenseServerMacInstaller.dmg (where ‘x’
denotes the version number).

2. Double-click on the disk image (.dmg) to open a window containing the installer app (.app).

3. On the network host machine, open the Terminal.

4. Right-click on the installer app and choose Show Package Contents. Open the Contents directory
and then the MacOS directory. Drag the file installbuilder.sh into the Terminal to add the path. After
the path, type a space and the following text:

--mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

Example of the final command:

/Volumes/DNASTAR\ License\ Server/DNASTAR\ 15.0.0\ License\ Server\ Mac\ Installer.app/
Contents/MacOS/installbuilder.sh --mode unattended --dnastarProductKey xxxxxxxx-xxxx-
xxxx-xxxx-xxxxxxxxxxxx

5. Press Enter. If a security warning appears, choose Yes.

A folder named LasergeneClient’x’ will appear on the desktop. This folder contains the .lshost files you will
need to set up the clients.
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Install and uninstall the client & standalone
software on Windows
To install:

As an alternative to the traditional method of installing standalone or network client software, you can use
the Windows command prompt to perform the installation “silently”:

1. Download the standalone/client installer DNASTARLasergene’x‘WinInstaller.exe (where ‘x’ represents
the version number).

2. (network installation only) Move the standalone/client installer into the _LasergeneClient’x’_folder that
was created during License Server installation. Then copy the entire folder to the desktop of the client
machine.

3. On the machine where the standalone/client software will be installed, open a command prompt.

4. Drag the installer executable into the command prompt to add the path. After the path, type a space,
then add this text:

If you are using a standalone key, add:

--mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

If you are using an IP address, add:

--mode unattended --dnastarServerIP xx.xx.x.xxx

In place of the “x’s,” use the IP address specified in the _LasergeneClient’x’_folder.

Example of the final command:

C:\Users\<username>\Desktop\DNASTARLasergene150aWinInstaller.exe --mode unattended --
dnastarServerIP 55.55.5.555

5. Press Enter. If a security warning appears, choose Yes.

To uninstall:

Open a command prompt and run the following command:
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“C:\Program Files (x86)\DNASTAR\Uninstall Lasergene ‘x’.exe” --mode unattended

… where ‘x’ represents the version number.
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Install and uninstall the client & standalone
software on Macintosh
To install:

As an alternative to the traditional method of installing standalone or network client software, you can use
the Macintosh Terminal to perform the installation “silently”:

1. Download the standalone/client installer DNASTARLasergene’x‘MacInstaller.dmg (where ‘x’
represents the version number). Double-click on the disk image (.dmg) to open a window containing
the installer app (.app).

2. (Network installation only) Move the standalone/client installer file (.app) into the LasergeneClient’x’
folder that was created during License Server installation. This folder contains the files LG‘x’.lshost,
NG‘x’.lshost, AS‘x’.lshost. Then copy the entire folder to the client machine. If you are using MacOS
10.14 or earlier, the folder can be placed anywhere, such as the client desktop. If you are using
MacOS 10.15 and later the LasergeneClient’x’ directory should be placed at the top level of the user
directory or the shared user directory, i.e. /Users/USERNAME/LasergeneClient or /Users/Shared/
LasergeneClient.

3. Open the LasergeneClient’x’ folder, right-click on the .app file and choose Show Package Contents.
Navigate to Contents/MacOS. You should see a file named installbuilder.sh.

4. On the machine where the standalone/client software will be installed, open the Terminal. Drag the
installbuilder.sh file and drop it into the Terminal to provide the path. After the path, type a space,
then add this text:

If you are using a standalone key, add:

--mode unattended --dnastarProductKey xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

If you are using an IP address, add:

--mode unattended --dnastarServerIP xx.xx.x.xxx

WARNING: If you are using Mac OS 10.15 or later and instead run the installer from
~/Desktop, ~/Documents, or ~/Downloads, the .lshost or .keyhost files will not be
properly copied to the Licenses directory.

!

Lasergene Installation Guide - 17.3_en

Copyright DNASTAR, Inc. 2022 Page 38 of 85

https://www.dnastar.com/license.aspx


In place of the “x’s,” use the IP address specified in the _LasergeneClient’x’_folder.

Example of the final command:

/Volumes/DNASTAR\ Lasergene\ 15/DNASTAR\ Lasergene\ Installer.app/Contents/MacOS/
installbuilder.sh --mode unattended --dnastarServerIP 55.55.5.555

5. Press Enter. If a security warning appears, choose Yes.

To uninstall:

Open the Terminal and run the following command:

“/Applications/DNASTAR/Uninstall Lasergene ‘x’.app/Contents/MacOS/installbuilder.sh" --mode
unattended
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Authorize silently on Windows
If you did not authorize a client or standalone installation at the time of installation, you can do so at any
time by launching the Navigator and clicking on License Manager, located in the Utilities Section.

To instead authorize the Lasergene software silently, follow these instructions:

1. On the machine where the standalone/client software was installed, open a command prompt.

2. Drag the installer executable into the command prompt to add the path. After the path, type a space,
then add this text:

If you are using a standalone key, add:

-q -k xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

If you are using an IP address, add:

-q -l xx.xx.x.xxx

In place of the “x’s,” use the IP address specified in the LasergeneClient'x' folder.

Example of the final command:

"C:\Program Files (x86)\DNASTAR\Lasergene 15\DNASTARLicenseManager.exe" -q -l
55.55.5.555
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Authorize silently on Macintosh
If you did not authorize a client or standalone installation at the time of installation, you can do so at any
time by launching the Navigator and clicking on License Manager, located in the Utilities Section.

To instead authorize the Lasergene software silently, follow these instructions:

1. On the machine where the standalone/client software was installed, open the Terminal.

2. Drag the installer app into the Terminal to add the path. After the path, type a space, then add this
text:

If you are using a standalone key, add:

-q -k xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx

In place of the “x’s,” use the alphanumeric string from the My Licenses page of the DNASTAR
website.

If you are using an IP address, add:

-q -l xx.xx.x.xxx

In place of the “x’s,” use the IP address specified in the LasergeneClient'x' folder.

Example of the final command:

/Applications/DNASTAR/Lasergene\ 15/DNASTARLicenseManager.app/Contents/MacOS/
LicenseManager -q -l 55.55.5.5
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Install Lasergene on KeyServer systems

Lasergene 16.0 and higher versions support KeyServer 7.5 and 7.6. The following instructions explain how
to set up the Lasergene license server and client for KeyServer. This installation requires the following files,
which you should have received in an email from DNASTAR: Lasergene.lic, ArrayStar.lic and NGen.lic;
LG’x’.keyhost, AS’x’.keyhost and NG’x’.keyhost, where ‘x’ represents the version number.

On the KeyServer host machine:

1. Copy all of the .lic files you received to the following folder:

• Windows: C:\Program Files\Sassafras K2\Server\KeyServer Data

• Mac: Applications/Sassafras K2/Server/KeyServer Data

2. Restart the KeyServer service as described in your KeyServer instructions.

3. Create a folder (e.g., LasergeneClient’x’) and place it at the top level of the user directory or the
shared user directory, i.e. /Users/USERNAME/LasergeneClient or /Users/Shared/LasergeneClient.

4. Copy all of the .keyhost files you received into the new folder.

5. Log in to your DNASTAR account and go to the My Account page. Press the appropriate button to
download the client installer (Client for Mac OS X, Client for Windows).

6. (Macintosh only) Double-click on the disk image (.dmg) to open a window containing the installer app
(.app).

7. (all platforms) Move the executable file (.exe) or installer app (.app) into the new folder with the copies
of the .keyhost files.

8. Move a copy of the folder to each of the client machines and place it at the top level of the user
directory or the shared user directory, i.e. /Users/USERNAME/LasergeneClient or /Users/Shared/
LasergeneClient.

This topic applies only to network installations.*
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On each of the client machines:

Install the Lasergene client software as described in Simple guide to installation or Detailed guide to
installation.

Troubleshooting:

Issue Resolution

When attempting to
launch a DNASTAR
application on the
KeyServer network, the
error “Debug String”
appears

A “Debug String” error can occur when you or an administrator uses Sassafras
KeyConfigure to key or patch a DNASTAR application. DNASTAR applications
require a vendor-generated license and may not launch successfully after being
modified in this way. To prevent this problem, please use only the license file
provided by DNASTAR for running DNASTAR applications on a KeyServer network.

KeyConfigure does not
display the latest
installed version of
DNASTAR Lasergene
after upgrading from a
previous version

After updating from a previous version of Lasergene, KeyConfigure may continue to
display the previous version number. To correct this issue:

1. From the KeyConfigure Products Window, double-click on a DNASTAR
application to display its Product Details window.

2. Change the version field to the correct version.

3. Close the Product Details window.

Repeat steps 1-3 for each of the other affected DNASTAR applications.

For more information, see the KeyConfigure online help.

WARNING: If you are using Mac OS 10.15 or later and instead place the folder in
~/Desktop, ~/Documents, or ~/Downloads, the .keyhost files will not be properly copied
to the Licenses directory.

!
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Install ArrayStar on a Macintosh machine
The ArrayStar application is part of Lasergene, but can only be installed on the Windows operating system.
It is omitted in standalone or client installations to Macintosh machines. However, if the Macintosh is running
Windows on Parallels Desktop, you can perform a Windows installation of Lasergene, allowing the
Macintosh user to access ArrayStar. The following topics describe the steps that must be taken prior to the
Lasergene client installation.

Step 1: Download and install Parallels Desktop

If you have not already installed a supported version of Parallels Desktop:

1. Go to the Parallels Desktop website and follow the on-screen instructions to complete the purchase
and download of Parallels Desktop.

2. After the download is complete, double-click on the Parallels Desktop disk image (.dmg) to open a
window containing the installer app.

3. To launch the installer, double-click Install. Follow the on-screen instructions until the Installer notifies
you that you successfully installed Parallels Desktop. Click Close to complete installation.

4. To start Parallels Desktop, open Applications and double-click Parallels Desktop.

5. Activate Parallels Desktop. The activation key will be in your email.

For more information, see: Parallels Desktop / Installing Parallels Desktop

Step 2: Download and install Windows

If you have not already installed a supported version of Microsoft Windows:

1. Go to the Microsoft website.

2. Download of the Full version, not the Upgrade version, of the current edition of Windows. We
recommend choosing the Windows Professional edition.

3. Follow the on-screen instructions to complete purchase of the software.

4. Start the Download Manager and download will begin.

Wait until the status of the download is "finished" before exiting. For users with average
download speeds, this download may take several hours to complete.*
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5. Open Parallels Desktop and select New Windows Installation.

6. Follow the on-screen instructions to install a supported version of Windows on your Parallels Desktop.
The Virtual OS will reboot several times during this process. This will not affect the Mac operating
system.

7. After Windows is successfully installed, the Parallels Desktop icon will appear in the Mac dock. When
you open Parallels Desktop for the first time, you will be in the "Extended Coherence" mode. You may
change this mode using the Mac Menu bar in the Parallels Desktop’s View Menu.

Step 3: Configure Parallels Desktop

Configure Parallels Desktop as follows:

1. Go to the Parallels menu bar on the Mac machine and select Virtual Machine > Shut Down.

2. Go back to the Parallels menu bar and select Virtual Machine > Configure.

3. Click on the General Tab.

4. Change the number of CPUs allocated to your Parallels Desktop to half the total that your Mac
computer has. For example if your Mac has 8 cores available, choose 4 cores.

5. Change the Memory to 8GB by typing 8000 in the text box or sliding the arrow to the right.

6. Click on the Hardware tab.

7. Select Hard disk in the menu of the left side.

8. Click the Edit button and then change the hard disk size to at least 100GB.

9. Select Network in the list on the left.

10. Change type to Default Adaptor in the drop down menu under Bridged Network.

11. Click OK, then Windows ‘x’ Click here to start on your Parallels Desktop (where ‘x’ is the version
number).

Step 4: Install DNASTAR Lasergene

Follow the steps in Standalone and network client installation for Windows.

Microsoft recommends that you always run antivirus software and keep it up to date.*
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Move Lasergene to another computer
If you move your licensed copy of Lasergene to another computer, you will need to uninstall the copy on the
original computer. Before initiating the “uninstall” procedure, you must manually move any user-generated
files from SeqBuilder Pro to the new computer or they will be lost.

The list below shows the files you need to copy and their locations. Be sure to move the files to the same
location (file path) on the new computer. If you have never added to the Feature Library or Cloning Vector
Catalog, you do not need to move these files.

Item Windows location Mac location

User-generated feature libraries
C:\Users\‹username›\AppData\Local\
DNASTAR\UserFeatures.library

/Library/Preferences/
DNASTAR/
UserFeatures.library

Vector catalogs with user-added
vectors

C:\Users\Public\Documents\
DNASTAR\Lasergene ‘x’ Data\
CloningVectors.sbp

/Applications/DNASTAR/
Lasergene ‘x’ Data/
CloningVectors.sbp

User-modified enzyme
(Enzymes.ezd) and selector
(EnzymeSelectors.sel) files

C:\ProgramData\DNASTAR\
DataManager\1.0

/Library/Preferences/
DNASTAR/DataManager/1.0

User-modified SeqBuilder layout
templates

C:\Users\‹username›\AppData\Local\
DNASTAR\UserDefault.lyt

/Library/Preferences/
DNASTAR/UserDefault.lyt

In the above file paths, ‘x’ represents the Lasergene version number.

Note: Depending on your computer’s operating system, some of these files may be hidden
by default. Instructions for revealing hidden files can easily be found online.*
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Network license server administration
The topics in this section are designed to help an IT department (or similar) to administer the DNASTAR
network license server.

• Restart, stop and uninstall the license server

• Verify license server status

• Monitor how many licenses are checked out to whom

• Troubleshoot client access to the license server

• Obtain an audit report of Lasergene usage

• Purchase additional uses or license additional applications

• Access additional administrative tools for managing the network
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Restart, stop and uninstall the license server
Task Windows Macintosh

Restart

Navigate to Control Panel > Administrative Tools > Services. On the
list, right-click on DNASTARLicenseServer and choose Restart. After
restarting, check WlmAdmin to confirm the server is running with the
correct number of modules and licenses.

Double-click on /Library/
DNASTARLicenseServer/
start_ls.command

Stop
Navigate to Control Panel > Administrative Tools > Services. On the
list, right-click on DNASTARLicenseServer and choose Stop.

Double-click on /Library/
DNASTARLicenseServer/
stop_ls.command

Uninstall
Use the uninstall utility located in Control Panel > Programs >
Uninstall a Program.

Double-click on /Library/
DNASTARLicenseServer/
uninstall_ls.command
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Verify license server status
On Windows:

1. Launch WlmAdmin.exe from C:\Program Files (x86)\DNASTAR-LicenseServer\Admin\.

2. Choose Edit>Defined Server List, add the IP address of your Server, and click OK. Then click the
plus sign (+) next to Defined servers.

3. In the ensuing list, click the plus sign (+) next to your server.

4. Click on any of the modules listed, then look on the right side of the dialog to find the Feature
Information section (under Statistics).

5. Confirm that the “Total” column contains the correct number of uses. Confirm this with all the
modules, including Lasergene 6.

6. Navigate to Control Panel > Administrative Tools > Services.

7. Find “DNASTARLicenseServer” on the list and make sure it is Started.

On Macintosh:

1. Open the Terminal and enter: /Library/DNASTARLicenseServer/lsmon x.x.x.x, where x.x.x.x. is the IP
address. A string of text will appear, broken into sections based on the total number of modules plus
one. Lasergene will be one of these sections. Each section will list the module and the “Max
concurrent user(s).”

2. Verify that all the correct modules and correct number of uses appear on the list.

3. Navigate to Applications > Utilities > Activity Monitor. Look at “All Processes” to verify that lserv is
running.

“6” is part of the feature name, which is the same for all versions, and does not reflect what
version you are running. For example, versions 9 and later clients can be run from a version
6 server.
*
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Monitor how many licenses are checked out
to whom
You can use the server to get a snapshot of who is currently using the licenses and how many are checked
out.

From the Windows Start menu, find and select All Programs > DNASTAR License Server > Administer
License Server. Find your server in the list on the left side. The right side of the window will provide
information about your license and who is using the software at that instant. Use View > Refresh to get
updated information.

On Macintosh, the utilities are located in /Library/DNASTARLicenseServer. The utility lsmon provides similar
information to WlmAdmin.exe. On Macintosh, drag and drop lsmon into Terminal (usually located in
/Applications/Utilities), enter a space, then type localhost to find all of the information about the server. Or
enter the following command:

Lasergene Installation Guide - 17.3_en

Copyright DNASTAR, Inc. 2022 Page 50 of 85



sudo /Library/DNASTARLicenseServer/lsmon localhost

Note that for Lasergene, each application will appear followed by the number 6 (e.g. GeneQuest 6),
however this does not reflect the version of Lasergene you are running. For additional information, see
Verify license server status.
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Troubleshoot client access to the license
server
Troubleshooting topics that deal with client access to the license server are:

• Error message ‘All licenses are in use’

• Error message ‘Cannot connect to License Server’

• License Server’s IP address has changed
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Error message: “All licenses are in use”
Clients may receive the message "All licenses are in use" even though some licenses are available. This is
because licenses may not be released if a client shuts down or reboots their computer without closing a
DNASTAR application. There is a two hour timeout period before these ‘inactive’ licenses are released by
the server. For more information, contact support@dnastar.com.
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Error message: “Cannot connect to License
Server”
If clients get the message "Cannot connect to license server" it is likely being caused by one of the
following:

• The client machine is no longer connected to the network. To verify, try launching a web browser and
connect to an external website or use a different application to open a file that is on your network.

• The license server machine is down or the service is not working. To remedy, restart the license
server machine.

• A new security patch or firewall prevents the machine from locating the license server. For information
on allowing clients to access the server through a firewall, see Handle a firewall on the license server
machine.

• The license server machine does not have the same IP address or name. If the IP address or name
has changed, this information will need to be changed in the lshost file for every client machine. lshost
is a text file that can be opened and modified with a text editor like Notepad or TextEdit. For
Lasergene clients, the filenames are LGx.lshost, ASx.lshost, and NG‘x’.lshost, respectively. See
Installed Lasergene file locations for the locations of the .lshost files.
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License server’s IP address has changed
If you have performed a network installation and the IP address of the license server changes, you will need
to update the IP address on the client machines. Launch DNASTAR Navigator and click on the License
Manager application. Enter your server’s new IP Address or Hostname and click Authorize.
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Obtain an audit report of Lasergene usage
A +usage log file +is automatically created by the DNASTAR network license server installer. By default, the
maximum size of the usage log file is 1 megabyte. Also by default, once the maximum size of the file is
reached, the license server will create a backup log file. The maximum number of backup files is 99. To
display the information into a readable table:

On Windows:

The log file dnals.log can be found at C:\Program Files (x86)\Common Files\DNASTAR-LicenseServer.
Open a command window by going to the Start Menu, typing cmd in the Search field and then clicking
Enter. Enter the following command:

• C:\Program Files (x86)\DNASTAR-LicenseServer\Admin\lsusage.exe – l

• C:\Program Files (x86)\Common Files\DNASTAR-LicenseServer\dnals.log

On Macintosh:

The log file DNASTARLicenseServer.log is located in /Library/Logs. Open the Terminal, usually found at
/Applications/Utilities, and then enter the following command: sudo /Library/DNASTARLicenseServer/
lsusage -l /Library/Logs/DNASTARLicenseServer.log

_____________________________________________________________________

The Usage Summary report can be limited using other variables such as a date range. See the file
documentation.html installed with your license server for more information.

On Windows:

Open C:\Program Files (x86)\DNASTAR-LicenseServer\Documentation\documentation.html. Select the topic
About the Sentinel RMS Utilities>lsusage.

On Macintosh:

Open /Library/DNASTARLicenseServer/documentation.html. Select the topic Administrator
Commands>lsusage-Display the Sentinel RMS Development Kit Usage Log File.

C:\Program Files (x86)\DNASTAR-LicenseServer contains a shortcut (named log) that leads
to the dnals.log file_._*
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Purchase additional uses or license
additional applications
After contacting your DNASTAR representative and placing the order, you will need to reauthorize the
server. (No changes will be required for the client machines). To reauthorize the server, launch the
LicenseManager application from the following directory:

• Windows: C:\Program Files (x86)\DNASTAR-LicenseServer\Server

• Macintosh: /Library/DNASTARLicenseServer

Enter the Product Key provided by your DNASTAR representative. After successful authorization, restart the
service to ensure the changes are in effect.
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Access additional administrative tools for
managing the network
For existing KeyServer customers, DNASTAR offers a KeyServer-compatible version of Lasergene. For
details, please contact DNASTAR.

Once you have received a KeyServer authorization email from DNASTAR, proceed to Install Lasergene on
KeyServer systems.
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Installed Lasergene file locations
The following file names use ‘x’ to represent the version number.

File Category Application Path

Application

ArrayStar (Win)
Windows: C:\Program Files
(x86)\DNASTAR\Lasergene
x\ArrayStar

SeqNinja (command
line; Win)

Windows: C:\Program Files
(x86)\DNASTAR\Lasergene
x\SeqNinjaCL

Navigator (Win)
Windows: C:\Program Files
(x86)\DNASTAR\Lasergene
x\Navigator

All others (Win) and all
Macintosh

Windows: C:\Program Files
(x86)\DNASTAR\Lasergene
x

Macintosh: /Applications/
DNASTAR/Lasergene x

Data Manager (DMx, DMx.exe)

SeqBuilder Pro,
Protean 3D,
GeneQuest, MegAlign
Pro

Windows: C:\Program Files
(x86) \DNASTAR\Lasergene
x

Macintosh: /Applications/
DNASTAR/Lasergene x

Data Manager State File

SeqBuilder Pro,
Protean 3D,
GeneQuest, MegAlign
Pro

Windows: C:\Program Data\
DNASTAR\DataManager

Macintosh: /Library/
Application Support/
DNASTAR/DataManager,

/Library/Preferences/
DNASTAR/DataManager

License Manager All

Windows: C:\Program Files
(x86)\DNASTAR\License
Manager
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Macintosh: /Applications/
DNASTAR/License Manager

Server License File (lservrc), Server License Manager
(DNASTARServerLicenseManagerx), Server
Executables (lserv, lservnt.exe)

All

Windows: C:\Program Files
(x86)\DNASTAR-
LicenseServer\Server

Macintosh: /Library/
DNASTARLicenseServer

Standalone & Trial Licenses (*.license), License Server
Client License (*.lshost), Key Server Client License
(*.keyhost)

All

Windows: C:\Program Data\
DNASTAR\Licenses

Macintosh: /Library/
Application Support/
DNASTAR/Licenses

Preferences

Protean 3D, Navigator,
SeqNinja (DNA*),
GenVision Pro

Windows:
C:\Users\<user>\DNASTAR

Macintosh: /Library/
DNASTAR

ArrayStar

Windows:
C:\Users\<User>\AppData\
Roaming\DNASTAR\
ArrayStar

All others

Windows:
C:\Users\<user>\AppData\
Local\DNASTAR\

Macintosh: /Library/
Preferences

AppData is a hidden folder in Windows. To unhide the folder, go to Organize > Folder and
Search Options > View > Show Hidden files and folders.*
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Types of Lasergene licenses
A Lasergene license is based on the installation type, number of users and on the type of anticipated usage
(e.g., a standalone license for research use only, a site license for professional use, etc.).

By usage type:

License
Type

Description

Commercial/
Research

Applies to commercial users that are involved in research.

Commercial
Services

Applies to commercial users that provide sequencing or diagnostic services for outside clients.

Academic/
Non-Profit

Applies to most academic, governmental, and non-profit users.

Educational
Available on a per-semester basis to those teaching Lasergene software usage to students in a
classroom setting.

Free Trial Results obtained with this type of temporary license may not be used in publications.

Added
Value

Includes access to the following databases: Variant Annotation Database (ArrayStar),
Transcription Factor Database (GeneQuest), Transcript Annotation Database (SeqMan NGen /
SeqMan Pro).

By installation type and/or number of licenses:

License
Type

Description

Standalone Allows installation of Lasergene on a single computer with full-time access to the programs.

Network

Allows you to install a license server on any Macintosh or Windows computer. The license server
limits the number of simultaneous uses to the number of systems you purchased. Therefore, you
can install the client software on an unlimited number of Macintosh or Windows on the same
network as the license server. This computer must be running constantly so that all client
machines will always have access to the client software. Also, the server computer must have a
static IP address, manually configured in the TCP/IP settings of the network card on that server.
In addition, if one computer is running two or more applications this computer would count for
only one simultaneous use. Therefore, if you had a 3 system network, you would have 2 more
uses left.

KeyServer Allows you to run Lasergene on an existing KeyServer network.
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Site
Via a negotiated agreement, organizations can request a large number or an unlimited amount of
Lasergene licenses.

Cloud

All DNASTAR software can be licensed to run on the DNASTAR Cloud, a service offered through
Amazon Web Services’ Amazon Cloud that allows you to access DNASTAR Lasergene software
online from anywhere in the world. Flexible term licenses for the Cloud are available to meet your
specific needs. Alternatively, you may set up your own account with AWS and create an access
key to use the DNASTAR Cloud. Click here for information on the DNASTAR Cloud Desktop,
DNASTAR Cloud Assemblies and DNASTAR Cloud Data Drive.
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Accessing and using the Lasergene free trial
We at DNASTAR welcome you to try a fully-functional version of Lasergene: the most cited commercial
software of its class, with 72,000 citations and counting!

Requesting and using the Lasergene free trial involves two simple steps:

• Step 1: Request a free trial
• Step 2 (option A): Try a subset of the Lasergene applications online; no need to download or install

anything!
• Step 2 (option B): Install the complete Lasergene package on your computer

We want your free trial experience to be an easy and enjoyable one. If you have questions or issues that are
not covered by this guide, please do not hesitate to email our friendly support staff.
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STEP 1: Request a free trial
If you plan to use the instant free trial on the cloud and want the best user experience, we strongly
recommend using the Google Chrome browser (download here for free). However, the free trial supports
all major browsers, including Mozilla Firefox, Safari, Internet Explorer, Microsoft Edge.

Go to the DNASTAR Free Trial Request page and fill out the form (gray background) on the right of the
page.

Click the blue button: Access My Free Trial. Decide which type of free trial best suits your needs.

OPTION A: Instantly try SeqBuilder Pro, Protean 3D, MegAlign Pro and SeqMan Pro online if:

• You want to explore just the most popular Lasergene applications … OR…
• You don’t want to download a 500 MB file … OR …
• You are not authorized to install software on your computer.

OPTION B: Download and install the complete Lasergene suite on your computer if:
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• You need trial access to the complete Lasergene suite… AND…
• Your Internet speeds allow you to easily download a 500 MB file.
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STEP 2 (OPTION A): Try Lasergene online
After completing the free trial request, you are asked to choose between installing the software or trying it
online. If you decide to try Lasergene online, the application process continues with the step below.

Press the Start Instant Trial button on the left.

You will be taken to a new browser window called DNASTAR on AppStream. The Lasergene free trial is
provided through Amazon’s AppStream, a cloud service that allows users to try software without needing to
install it on a local computer. You will also receive an e-mail from DNASTAR describing how to log back into
your free trial once you leave it. If you do not receive the e-mail, please check your spam folder.

A progress wheel counts down the time to prepare your session—usually about 2 minutes.

While waiting for the session to load, you may wish to click on the original browser tab (DNASTAR –
Software for Molecular Biology) to watch a video on using Lasergene in the cloud.

A specialized version of the DNASTAR Navigator appears:
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• Use the blue tabs on the left to choose a general topic of interest (e.g., “Molecular Biology,”
“Transcriptomics”). The workflows for that topic are displayed on the right. The Get Started tab links
directly to this help document.

• To launch a workflow in Lasergene, click on its name.

• To see a tooltip about a workflow, hover over the name of the workflow.

• To read detailed information or see a video about a workflow, click its “info” button.

See the following topics to learn how to:

• Find and use tools for launching applications, switching windows and more

• Work with data files to learn how to upload your data to the cloud and download cloud results to your
computer

• End a free trial session

• Return to the free trial from the same or another computer

Or click the play button below to see the same information in video format:
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<div class="player-unavailable"><h1 class="message">An error occurred.</h1><div class="submessage"><a
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Find and use the tools
Near the top of the browser window is a light gray toolbar containing AppStream tools. When using your
Lasergene free trial, you may find many of these tools very useful.

Tool
name

Icon Description

Launch
app

Lets you choose from a list of workflows. If you choose a workflow pertaining to an
already-open application, nothing will happen. If you choose a workflow pertaining to a
different application, the new application will open. The original application(s) will
continue to be available.

Switch
windows

If multiple applications are open, this tool toggles between displaying multiple
application windows as overlapping or side-by-side.

My files
Opens the My Files folder containing all of your cloud files. For more information, see
Work with data files.

Clipboard This tool and its two sub-options are not supported in the Lasergene free trial.

Settings
This tool offers four options, none of which are necessary or recommended as part of
the free trial.

Enter
fullscreen
mode

To open the free trial in full screen mode. Once in full screen mode, you can access the
tools by hovering the cursor near the center-top of the screen. To return to normal

mode, click the Exit fullscreen mode tool ( ) or press the Esc key.

Toggle
multiple
monitors

To toggle between displaying the free trial on different monitors, when more than one
monitor is in use.

Profiles

This tool, located to the right of the other tools, provides two options:

• Send feedback – Opens the DNASTAR Contact us page.
• End session – To end the current free trial session. To return to the free trial

once you have left the session, see Return to the free trial.
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Work with data files
The “My Files” file explorer lets you see all of the files on your free trial cloud-space. These files consist of
the Lasergene demo data files, files you have uploaded from your own computer, and files created in the
course of using your Lasergene free trial.

The initial file structure consists of two folders, one of which contains two subfolders:

• Home Folder – This folder and its subfolders are the only places to which you should save or upload
data. Storing data anywhere else will result in the data being lost after you leave the cloud session.
The two subfolders are:

◦ Lasergene Data – Contains all of the data needed to follow the SeqBuilder Pro, Protean 3D,
MegAlign Pro and/or SeqMan Pro tutorials on the DNASTAR website.

◦ SAVE HERE – The location in which you should save results files and upload data from your
computer.

• Temporary Files – The storage location for temporary files created by Lasergene applications in the
course of performing analyses. We recommend that you do not open or use this folder.

For information on working with data files, see the following topics:

• Open files in a Lasergene application
• Save Lasergene application results
• Use the cloud file explorer
• Create a folder in the cloud
• Upload files to the cloud
• Delete files from the cloud
• Download a cloud file to your local computer
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Open files in a Lasergene application
To open files in a Lasergene application:

While using the online free trial, you can only access files located in the online file explorer, “My Files”.
These files include the Lasergene demo data plus any files you have uploaded to the file explorer. You
cannot directly open files located on your local computer.

Using the File > Open command from within a Lasergene application takes you directly to the Home
Folder.

• Lasergene demo data is located in the Home Folder > Lasergene Data folder.

• Data uploaded from your local computer or data saved while using your Lasergene free trial should be
located in the Home Folder > SAVE HERE folder.
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Save Lasergene application results
To save results from a Lasergene application:

When using a command like File > Save from within a Lasergene application, save the file to the Home
Folder > SAVE HERE folder or to a sub-folder that you created in that location.

You can also save in the Lasergene Data folder, though this is not recommended.

If you save your results to any location outside the Home Folder, the files will be deleted
when you leave the session.

!
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Use the cloud file explorer
To open the cloud file explorer:

Press the My Files tool ( ) near the top left of the DNASTAR on AppStream tab. The file explorer
contains two folders: Home Folder and Temporary Files.

To navigate “downward” to a subfolder or file:

Single-click on the name of the folder you wish to open.

To navigate “upward” to a parent folder:

Click on the left arrow in the blue bar at the top of the file explorer.

The absence of a left arrow indicates that you are already in the uppermost parent folder.
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Create a folder in the cloud
Creating data folders in the cloud is optional. However, you may wish to create folders to better organize
your input and results files in the SAVE HERE folder.

To create a new folder in the cloud:

1. Open the cloud file explorer by clicking the My Files tool ( ).

2. Navigate to the folder *Home Folder > SAVE HERE” or any of its user-created subfolders.

3. Press the Add Folder tool ( ) in the blue bar at the top of the file explorer, then type
the folder name into the text box.

4. Press the Enter key.
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Upload files to the cloud
To transfer one or more files from your local computer to the cloud:

1. Open the cloud file explorer by clicking the My Files tool ( ).

2. Navigate to the folder Home Folder > SAVE HERE or any of its user-created subfolders.

3. Once a file has been uploaded to the cloud, you cannot move it to a different folder. Therefore, you

should navigate to and open the desired folder, then press the Upload Files tool ( )
in the blue bar at the top of the file explorer.

4. Navigate to the file(s) of interest, select them, and press Open. A progress wheel shows the progress
of the upload. At the completion of the upload, the file(s) will be displayed in the file explorer.

Note: If you upload the same file to the same location multiple times, it will be uploaded and
saved each time with a parenthetical number suffix, e.g., “test(1).seq”.*
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Delete files from the cloud
Once you have uploaded a file or folder to the cloud, you can delete it any time.

1. Start in the Navigator and choose Window > Open Home Directory. This launches the Windows file
explorer.

2. Navigate to the file or folder location. We recommend that you not delete the upper-level default
directories named Home Folder and Temporary Files. Instead, to remove files or folders that are in
these directories, open the directory and select the files/folders you wish to delete.

3. Right-click on the files/folders you wish to remove and choose Delete.

4. You will be prompted to confirm whether or not you wish to delete the file.
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Download a cloud file to your local computer
To download files or folders from the cloud to your local computer:

1. Open the cloud file explorer by clicking the My Files tool ( ).

2. Navigate to the location of the file, which should be in the folder Home Folder > SAVE HERE or any
of its user-created subfolders.

3. Do either of the following.

• Click the name of the file you wish to download.

• Click the downward-facing arrow to the right of the filename and choose Download.

4. In the ensuing dialog, choose Save File and press OK.

The file is automatically saved to the default download location on your local computer.
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If you are using a browser other than Google Chrome AND have popups disabled, you will instead
receive this message from AWS AppStream:

Follow your browser’s instructions (usually located near the top of the browser window) to enable
popup messages and begin the download.

Note: If you have an earlier copy of Lasergene installed on your computer, another
alternative exists. You can use Open with to open the file in the locally-installed version of
the application shown in the drop-down menu.
*
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End a free trial session
To end an instant free trial session:

Closing the free trial browser window does not end your cloud session.

Instead, do any of the following:

• Use the Profiles tool near the upper right of the window and choose End Session.

• Stop using your Lasergene free trial for 2 hours. The session will end automatically.

• Use your Lasergene free trial for 12 hours in a row. At this point, you will receive a warning and the
session will close shortly thereafter.

After the session ends, you will see the following message:

To resume using the Lasergene software, see Return to the free trial.
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Return to the free trial
After closing your browser or closing a free trial session, you can return to the free trial using any computer
with an Internet connection. You do not need to use the same computer you used when you first used the
free trial.

OPTION A: Use the link in the e-mail that DNASTAR sent you when you applied for the free trial

1. Locate the e-mail from DNASTAR. If you did not receive the e-mail, please check your spam filter.

2. Click the link “Click here to get started”.

3. Click Accept and Start Instant Trial, then follow the same steps you used when beginning the free
trial.

OPTION B: Create a DNASTAR account and enter through your “My Account” page
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1. Go to the DNASTAR login page and click the link Forgot your password?.

2. Enter the e-mail that you used when you applied for the free trial and click Reset Password.

3. Check your inbox for an email with your newly-assigned DNASTAR password.

4. Return to the DNASTAR login page. Enter the email address and password from the email and press
Log In.

5. Click the Lasergene Instant Trial button on the top right.

6. Click on the free trial link to return to the free trial.
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Keyboard shortcuts for Mac users
Because AppStream is Windows-based, Macintosh free trial users should note that shortcuts use the
Control key instead of the Command key. To copy text, for instance, both Windows and Macintosh users
should use Control+C.

If you later purchase Lasergene, the commands in the installed version of Lasergene will be the traditional
ones used for these two operating systems.
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Print from a Lasergene application on the
cloud
While using a Lasergene application on the cloud, you may wish to use the File > Print command.

Since network discovery is disabled in AppStream (the Amazon application that powers the Lasergene free
trial), however, there are only two printer options: DCV Printer and Microsoft XPS Document Writer.

DCV Printer is similar to the Print to PDF command found in many other applications. Choose DCV Printer
to create a PDF from the selection and open it in a new tab. You can then print the PDF from your browser.
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STEP 2 (OPTION B): Install Lasergene on your
computer
When applying for a Lasergene free trial, you are asked to choose between installing the software or trying
it online. If you decide to install it, the application process continues with the steps below.

On the right side of the web page, press Download OSX (Macintosh users) or Download Windows
(Windows users).

If a save dialog appears, choose Save File.

The Lasergene installation file will will be saved to your default download location and—at nearly 500 MB in
size—will likely take several minutes to download completely. If the download hasn’t completed within 5-10
minutes, we recommend that you try the download again using one of our global host sites. Scroll to the
bottom of the Free Trial page and choose your location to get started.

IMPORTANT: Follow the rest of the procedure below, but be sure to leave the “Free Trial”
browser window open. As shown above, it contains the Product Key you will need to
authorize your free trial installation.

!
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Once the installation file has completely downloaded, follow the Lasergene installation instructions for
Windows or Macintosh, beginning with Step 2.

When the installation has finished, the DNASTAR Navigator will appear. The following brief video shows
how to use the Navigator to find and launch the software for your workflow of interest.

<div class="player-unavailable"><h1 class="message">An error occurred.</h1><div class="submessage"><a
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